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About This Guide

This guide describes how to use the Safety dashboards in Construction and Engineering
Intelligence. It describes the Benchmark and the Risk Forecast dashboards within the Safety
module.

Audience

This guide is intended for anyone using the Safety dashboards within Construction and
Engineering Intelligence.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Conventions

The following text conventions are used in this document.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.

About This Guide
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1
Construction and Engineering Intelligence
Overview

Construction and Engineering Intelligence is a smart AI-powered cloud application that
identifies potential safety issues associated with construction projects. Construction and
Engineering Intelligence's construction-trained AI delivers unbiased insights, predicts where to
focus your attention, and prescribes specific actions to mitigate safety risk.

Accessing Construction and Engineering Intelligence
When your organization is provisioned with Construction and Engineering Intelligence, you will
receive the Construction and Engineering Intelligence Application URL in a Welcome email.

To sign in for the first time as a user of Construction and Engineering Intelligence:

1. In your Welcome email, click the application URL

Note:

For a list of supported browser versions, see Client System Requirements.

2. In the Username field, enter the user name assigned to you.

3. In the Password field, enter your password. After your initial sign in, you can proceed to 
Resetting Your Password.

4. Click Sign In.

5. Use the Navigator pane to explore the menu options available to you. For more details,
see Navigation Overview.

About Your Login Credentials
New customers receive an initial email from no-reply@oracle.com to activate their Oracle
Cloud account. The link has an expiration date mentioned at the bottom of the email. Make
sure to activate your account before the link expires.

You will receive a separate welcome email that includes the URL to access Construction and
Engineering Intelligence.

Tip:

• If you do not receive either email, check the spam or junk folder in your email account, or
reach out to your customer success manager or Construction and Engineering Intelligence
administrator.
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• In case you miss the activation window to activate your Construction and Engineering
Intelligence account, visit the URL listed in the initial welcome email and select the Forgot
Password? link.

Resetting Your Password
You can reset your password for Construction and Engineering Intelligence at any time.

To reset your password:

1. Navigate to the Oracle Cloud Account Sign In page.

2. Select the Need help Signing in? Click here link.

3. On the Forgot your password page, enter your user name, and then click Next.

4. Review the on-screen message, and click Submit.

5. Select Password Reset in the email you receive.

6. On the Reset Your Password page, complete the New Password and Confirm New
Password fields.

Note:

The Confirm New Password field will not be active until your new password
meets the specified criteria.

7. Click Submit.

8. Select Click here to continue to navigate back to the Oracle Cloud Account Sign In
page, and log in with your new password.

Note:

To allow time for system processing, it is recommended that you wait a few
minutes before logging in with your new password.

Navigation Overview
The Home page of Construction and Engineering Intelligence displays the following menu and
options.
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Menu / Option Description

 Navigation
Menu

Select to expand or collapse the Navigator pane.

 Help
The Help menu displays the following options:

• Oracle Help Center: Select this option to access all guides in the
Construction and Engineering Intelligence library.

• Training: Select this option to access training resources available for
Construction and Engineering Intelligence.

• Support: Select this option if you need information on how to contact Oracle
Support.

• About: View the product version and build information of Construction and
Engineering Intelligence.

1 Displays the initials of the signed-in user.

Select this option to sign out of the application.

2 Navigator
The Navigator displays the modules you can access based on your role and the
modules your organization has purchased.

• Overview: This is the main landing page.
• Safety: Select this option to access the safety module.
• Analytics: Select this option to connect, build, and view visualizations in

Oracle Analytics Cloud. This module is displayed only if your organization has
purchased the license for Construction and Engineering Analytics.

• Administration: This option is available only if you are an administrator for
Construction and Engineering Intelligence. The following options display under
Administration:
– Data Management: Select this option to set up and manage data

sources.
– User Management: Select this option to set up and manage users.

3 The selected module page is displayed. You can select the tiles displayed on the
page to navigate within the selected module.

Navigating within the Application

You can navigate within the application using either the Navigator or the tiles on the page.

Using the Navigator:

1. Click the Navigation Menu to display the Navigator pane.

Chapter 1
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2. In the Navigator pane, select a module.

Examples:

• To access the Administration module: From the Navigation Menu, select Administration.

• To access the Analytics module: From the Navigation Menu, select Analytics. A new tab
opens with Oracle Analytics Cloud.

• To access the Benchmarks dashboard in the Safety module: From the Navigation Menu
pane, select Safety, then select Benchmarks.

• To access the Monitoring dashboard in the Safety module: From the Navigation Menu
select Safety, then select Monitoring.

Using tiles

From the Overview page or from any of the module pages, select the tiles displayed on the
pane.

Examples:

• To select the Administration module: From the Overview page, select the Administration
tile.

• To select the Analytics module: From the Overview page, select the Analytics tile. A new
tab opens with Oracle Analytics Cloud .

• To access the Benchmarks dashboard in the Safety module: From the Overview page,
select the Safety tile, then select the Benchmarks tile.

• To access the Monitoring dashboard in the Safety module: From the Overview page,
select the Safety tile, then select Monitoring tile.

Keyboard Shortcuts

General Interactive Keyboard Shortcuts

Action Keys

Move to the next tab stop Tab

Move to the previous tab stop Shift+Tab

Toggle between row selection and cell selection F8

Open the column header menu, when focus is on the column
header

Enter or Space

Increase column width, when focus is on the column header Windows: Ctrl+Right arrow

Mac: Ctrl+Cmd+Right arrow

Decrease column width, when focus is on the column header Windows: Ctrl+Left arrow

Mac: Ctrl+Cmd+Left arrow

Move column to next column position, when focus is on the
column header

Shift+Right arrow

Move column to the previous column position, when focus is
on the column header

Shift+Left arrow

Sort ascending on the current column, when focus is on the
column header

Windows: Alt+Up arrow

Mac: Option+ Up arrow

Sort ascending on the current column in addition to the
existing search columns, when focus is on the column header

Windows: Shift+Alt+Up arrow

Mac: Shift+Option+ Up arrow
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Action Keys

Sort descending on the current column, when focus is on the
column header

Windows: Alt+Down arrow

Mac: Option+ Down arrow

Sort descending on the current column in addition to the
existing search columns, when focus is on the column header

Mac: Shift+Option+Down arrow

Move to next tab stop in column header menu, when column
header menu is open

Tab

Move to previous tab stop in the column header menu, when
column header menu is open

Shift+Tab

Close the column header menu, when the column header
menu is open

Escape

Show help (if defined) for an item, when a single row is
viewed and focus is on the column

Windows: Alt+F1

Mac: Option+F1

Date Picker

Action Keys

Open the popup, when the input has focus and Display Mode
is set to popup

Down arrow

Close the popup and focus the input, when Display Mode is
set to popup

Escape

Focus the next element Tab

Note:

When the
Display
Mode is
set to
popup and
the last
element is
focused,
pressing
Tab moves
focus to
the first
element.
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Action Keys

Focus the previous element Shift+Tab

Note:

When the
Display
Mode is
set to
popup and
the first
element is
focused,
pressing
Tab moves
focus to
the last
element.

Move focus to the same day of the previous week Up arrow

Move focus to the same day of the next week Down arrow

Move focus to the previous day Left arrow

Move focus to the next day Right arrow

Move focus to the first day of the current week Home

Move focus to the last day of the current week End

Change the grid of dates to the previous month Page Up

Change the grid of dates to the next month Page Down

Change the grid of dates to the previous year Shift+Page Up

Change the grid of dates to the next year Shift+Page Down

Select the focused date, when Show Time is off Enter or Space

Select the focused date, when Show Time is on Enter or Space, then Done
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2
About Safety Dashboards

Benchmarks Dashboard

Use the Benchmarks dashboard to view how your project or portfolio of projects are
performing against our proprietary benchmarks. The three tabs (Company Level Benchmarks,
Project Level Benchmarks, and Project Directory) within the dashboard allow you to view risks
at the company level and the project level, and to view performance across your portfolio of
projects.

See Benchmark Dashboards for a detailed description of each dashboard and the metrics
behind the dashboard.

Risk Forecast Dashboard

Use the Risk Forecast dashboard to view projects that are at risk for having a safety incident.
Five tabs: (Weekly Risk Summary, Weekly Project Risk, Risk Report Card, Risk Level vs
Incident History, and Model Performance) within the dashboard allow you to track weekly risk
predictions at the company level and project level. You can use this dashboard to view project
risks along with the corresponding recommended actions, view the detailed data behind the
predictions, compare risk mitigation efforts for each week, and monitor the risk trends for the
life of your project.

See Risk Forecast Dashboards for a detailed description of each dashboard.

Benchmark Dashboards
The Benchmarks dashboard provides important metrics to help you gain insights into the
safety performance of projects your company manages. As a user with access to single or
multiple projects, you can use the dashboard to view how projects are performing against
company safety benchmarks. In addition to providing key metrics data, the dashboard also
provides actions you can take to help the project optimize safety performance.

The dashboard has three tabs: Company Level Benchmarks, Project Directory, and Project
Level Benchmarks. Use Company Level Benchmarks to view metrics for all projects or a
subset of projects. The Project Level Benchmarks allows you to view metrics for a single
project, and the Project Directory tab allows you to view metrics across multiple projects.

Accessing the Benchmark Dashboards

To access the benchmark dashboards:

1. From the Navigation Menu, click Safety, and then select Benchmarks.

The default page Company Level Benchmarks is displayed.

2. Select a tab:

• Company Level Benchmarks
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• Project Directory

• Project Level Benchmarks

Note:

Your access to dashboards is set by your administrator.

About Benchmark Metrics

The following metrics are displayed in the Benchmarks dashboard:

Worker Observation Rate (WOR)
It is the number of worker hours divided by the number of observations made over the same
duration. WOR is a measure of workforce engagement by the safety program in place on the
project. For example, a project having five workers working 40 hours a week (200 total hours)
and engaged in a safety conversation in their work area at least once in that week would result
in a WOR of 200 hrs./obs. The target value for the WOR metric is 100 hrs/obs.

Staff Observation Rate (SOR)
It is the number of worker hours divided by the number of observations made over the same
duration. SOR is a measure of how engaged project supervision is in the engagement of a
project. For example, a project having four staff employees who all work 40 hours each (160
hours total) perform a total of four observations that same week would result in an SOR of 40
hrs./obs. The target value of the SOR metric is 40 hrs./obs.

Incident Frequency Rate (IFR)
It is the number of incidents times 100,000 divided by the total number of hours worked over
the same duration. IFR is a measure of how frequently incidents of all severity levels are
reported on a project. This metric is indicative of a healthy reporting culture and shows that the
organization has established a safe environment for reporting all incidents, including minor
incidents. The target value of IFR is between 12.0 to 25.0. This equates to a project identifying
and reporting an incident for every 4,000 to 8,000 hours worked on a job site.

Average Incident Severity (AIS)
It is the average severity of all incidents that take place over a fixed duration. AIS measures
whether the incident being reported is of the right type. To calculate the AIS, incidents are
given a severity score based on their type as indicated below:

Severity (OSHA-USA) Severity (HSE- UK) Severity (AUS-WHS) Score

Near Miss Near Miss Near Miss 1

Property Damage Property Damage Property Damage 2

First Aid Injury First Aid Injury First Aid Injury 3

Recordable Injury Dangerous Occurrence/Over 3-Day
Incapacitation

Dangerous Incident/Serious Injury
or Illness

4

Restricted Duty/Transfer Over 7-Day Incapacitation Cases or Alternate Work 5

Lost Time Specified Injuries Lost Time 6

Fatality Fatality Fatality 7

Chapter 2
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Company Level Benchmarks
Use the Company Level Benchmarks dashboard to view metrics across all or a subset of
projects.

The dashboard displays key data to help you evaluate the selected projects against predefined
benchmarks. You can use this dashboard to:

• View the safety performance of all your projects at the company-level and compare them
against the predefined benchmarks.

• View the following safety metrics for your project: WOR, SOR, IFR, and AIS. For more
information, see About Benchmark Metrics .

• View recommended actions to take based on the project performance.

• View the data driving the metric results both in aggregate and over time.

 

 
The following screen elements are displayed on the Company Level Benchmarks dashboard:

Screen Elements Description

1 Displays the time the data was imported.

2 View Data button. Select to view the data used to generate the dashboard. The
following metrics are displayed in the dialog box:

• Incidents: All Incident Types, Recordables, Average Incident Severity,
Average Hours per Incident

• Observations: Total, Average Users, Risk Observation, Combined
Observation Rate

• Trade Labor: Manpower Entries, Average Number of Trades, Average
Number of Workers, Hours

• Payroll/Time cards: Payroll Entries, Hours, Staff Hours, Craft Hours

3 Filter icon. Select to filter on date range. The options include: Latest Import, All
Time, Last Week, Month to Date, Quarter to Date, and Year to Date.

Chapter 2
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Screen Elements Description

4 Metrics Tiles. Each tile displays the following information:

• Name of the metrics
• Severity badge (Critical, Warning): displays only if the metrics is above the

benchmark value.
• Metrics value
• Percentage above or below the benchmark
• Benchmark value
For more information, see About Benchmark Metrics.

5 Displays recommend actions if your project metrics are either above or below the
benchmark threshold.

6 Displays an interactive graph to view metrics over the time period and compares it
against predefined benchmark values.

7 Tabs to navigate to the Company Level Benchmark, Project Details, and Project
Level Benchmarks pages.

How to use the dashboard

• Review the high-level metrics displayed on the Metrics Tiles.

• View the metrics graph by selecting a metric from the Metrics Tiles. For example, when
you click the Worker Observation Rate WOR tile, the graph for the WOR metric is
displayed. It shows the time period (week ending), WOR values, benchmark values, and
the observation count.

• View the data for a specific time period by hovering over the graphic.

• View the recommended actions under the Metrics Tiles.

• View the data used to generate the graph by clicking the View Data button.

Project Directory
Use the Project Directory dashboard to view safety metrics for a selected list of projects.

The dashboard displays key data to help you view how projects are performing against
predefined safety benchmarks. You can use this dashboard to:

• See how selected projects are comparing against predefined safety benchmarks.

• Identify project safety metrics that are either below or above thresholds. The metrics are
color coded for easy identification.

• Filter the projects list to expand or narrow your search criteria.

• View the following safety metrics for all selected projects: WOR, SOR, IFR, and AIS. For
more information, see About Benchmark Metrics.

• View the data driving the metric results.
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The following screen elements are displayed on the Project Directory dashboard:

Screen Elements Description

1 Displays the time the data was imported.

2 More Actions drop-down menu:

• Select Projects: Opens the Select Projects for Comparison dialog box. You
can select the projects you want to view metrics and compare.

• View Data: Select to view the data used to generate the dashboard. The
following metrics is displayed in the dialog box:
– Incidents: All Incident Types, Recordables, Average Incident Severity,

Average Hours per Incident
– Observations: Total, Average Users, Risk Observation, Combined

Observation Rate
– Trade Labor: Manpower Entries, Average Number of Trades, Average

Number of Workers, Hours
– Payroll/Time cards: Payroll Entries, Hours, Staff Hours, Craft Hours

3 Filter icon. Select to filter on date range. The options include: Latest Import, All
Time, Last Week, Month to Date, Quarter to Date, and Year to Date.

4 Metrics Tiles - Each tile displays the following information:

• Name of the metrics
• Severity badge (Critical, Warning): displays only if the metrics is above the

benchmark value.
• Metrics value
• Percentage above or below the benchmark
• Benchmark value
For a description of the metrics, see About Benchmark Metrics.
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Screen Elements Description

5 Metrics Table - Provides detailed statistics for the observations and incidents
recorded at the project level. The following information is displayed:

• Project
• Observations

– Total
– Worker hours
– WOR (WOR at project level)
– Staff hours
– SOR (SOR at project level)
– Target Observations

• Incidents
– Total Incidents (Count of all incidents on that project)
– AIS (AIS at project level)
– IFR (IFR at project level)
– Target Incidents

6 Tabs to navigate to the Company Level Benchmark, Project Details, and Project
Level Benchmarks pages.

How to use the dashboard

• Choose the projects to compare:

1. From the More Actions drop-down list, choose Select Projects.

2. From the Select Projects for Comparison dialog box, select your projects and click
Apply.

• View the high-level metrics for all projects displayed on the Metrics Tiles.

• Compare the metrics for each project. The metrics are color coded for easy identification.

• View the data used to generate the table. From the More Actions drop-down list, choose
View Data.

Project Level Benchmarks
Use the Project Level Benchmarks dashboard to view safety metrics for a specific project.

The dashboard displays key data to help you view how your project is performing against
predefined safety benchmarks. You can use this dashboard to:

• See how your project is comparing against predefined safety benchmarks.

• View the following metrics for your project: WOR, SOR, IFR, and AIS. For more
information, see About Benchmark Metrics.

• View recommended actions based on project performance.

• View the data driving the metric results both in aggregate and over time.
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The following screen elements are displayed on the Project Level Benchmarks dashboard:

Screen Elements Description

1 Project drop-down list. Displays all the project you can access. The projects are
sorted in alphabetically order. Use the drop-down to select your project.

2 Displays the time the data was imported.

3 View Data button. Select to view the data used to generate the dashboard. The
following metrics are displayed in the dialog box:

• Incidents: All Incident Types, Recordables, Average Incident Severity,
Average Hours per Incident

• Observations: Total, Average Users, Risk Observation, Combined
Observation Rate

• Trade Labor: Manpower Entries, Average Number of Trades, Average
Number of Workers, Hours

• Payroll/Time cards: Payroll Entries, Hours, Staff Hours, Craft Hours

4 Filter icon. Select to filter on date range. The options include: Latest Import, All
Time, Last Week, Month to Date, Quarter to Date, and Year to Date.

5 Metrics Tiles. Each tile displays the following information:

• Name of the metrics
• Severity badge (Critical, Warning): displays only if the metrics is above the

benchmark value.
• Metrics value
• Percentage above or below the benchmark
• Benchmark value
For a description of the metrics, see About Benchmark Metrics.

6 Displays recommend actions if your project metrics are either above or below the
benchmark threshold.

7 Displays an interactive graph to view metrics over the time period and compares it
against predefined benchmark values.

8 Tabs to navigate to the Company Level Benchmark, Project Details, and Project
Level Benchmarks pages.

Chapter 2
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How to use the dashboard

• From the Project drop-down list, select a project.

• View the high-level metrics displayed on the Metrics Tiles.

• From the Metrics Tiles, select a metric to view the graph for the selected metric. For
example, when you select the Work Observation Rate WOR tile, the graph for the WOR
metric is displayed. It shows the week ending, WOR values, benchmark values, and the
observation count.

• Hover over the graphic to view the data for a specific time period.

• View the recommended actions under the Metrics Tiles.

• View the data used to generate the graph. Click the View Data button.

Risk Forecast Dashboards
Use the Risk Forecast dashboards to assess which of your projects are at risk of having a
safety incident in the coming week.

The dashboards also show the factors that are driving the risk and the actions project teams
can take to mitigate the risk. Multiple dashboards allow you to view either a high-level list of all
projects that are ranked based on their risk score, or view risks levels for individual projects.
Use these dashboards to:

• Monitor your projects closely and track the risk rankings on a weekly basis to see if
appropriate actions are being taken on the project.

• Review project priorities and recommended actions to help mitigate safety risks.

• Track model performance over time with a detailed list of safety incidents and the rank of
the project on which they occurred.

• Compare the risk level with the incident history for your project.

• View all risk factors applicable to your projects along with their definitions.

The following dashboards are part of the Risk Forecast dashboard: Weekly Risk Summary,
Weekly Project Risk, Risk Report Card, Risk Level vs Incident History, and Model
Performance.

Accessing Risk Forecast Dashboards

To access the Risk Forecast dashboards:

1. From the Navigation Menu, click Safety and then select Risk Forecast.

The default page Weekly Safety Risk Summary is displayed.

2. Select a tab:

• Weekly Safety Risk Summary

• Weekly Project Risk

• Risks Report Card

• Risk Level vs Incident History

• Model Performance

Chapter 2
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Note:

Your access to dashboard tabs is set by your administrator. The tab visibility is
based on user roles; a multi-project user has access to all tabs, while a single
project user can only access the Weekly Project Risk, the Risk Report Card, and
the Risk Level vs Incident History tabs.

Weekly Safety Risk Summary
Use the Weekly Safety Risk Summary dashboard to view a high-level list of all projects
ranked by the likelihood of an incident to occur in the week ahead.

You can use this dashboard to:

• View the overall risk ranking for the projects in your portfolio. The risk rank is based on the
likelihood of an incident occurring in the coming week.

• Understand the risk factors driving the incident risk on each project.

• Potentially reduce project risk by implementing the recommended action steps.

 

 
The following screen elements are displayed on the Weekly Safety Risk Summary
dashboard:

Screen Elements Description

1 Displays the date the data was last imported. The dashboard predictions are
based on the data for the week prior to this date.

2 Project Risk Rank Ending - Displays the week ending date. The project ranking is
calculated for the week ending on the date specified.

Chapter 2
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Screen Elements Description

3 View Company Data button. Select to view the data used to generate the
dashboard. The following metrics are displayed in the dialog box:

• Incidents: Total Last Week, Recordables Last Week, JTD Incidents, JTD
Recordables

• Observations: Total Last Week, Worker Observation Rate, Staff Observation
Rate, Average Observation Risk

• Trade Labor: Total Worker Days, Total Hours, Percent Apprentices,
Supervision Ratio

• Payroll/Head Count: Total Head Count, Total Hours, Safety Hours, Safety
Ratio

• Photos: Photo Count, Photo Coverage, Work at Height Composite

4 Filter button. Select to filter the projects list.

5 Rank column. Display a numerical risk rank for each project. The risks are color
coded as follows:

• Red: High risk
• Brown: Elevated risk
• Gray: Lower risk

6 Project column. Displays the ID and the name of the project.

7 Change column. Displays the change in project risk rank from last week's
predictions. The numeric value shows the change in ranking, and the arrow
indicates whether the project has moved up or down the list. An up arrow in red
color indicates that the project's risk rank has increased, while a down arrow in
green indicates that a project has decreased its project risks.

A value of 0 indicates that there is no change in risk rank from last week.

8 Priorities and Actions pane. Displays the project priorities and the recommended
actions. The priorities are labeled as High, Medium, Low, and No action. The
metric is listed along with the recommended actions. You can hover over the Tool
Tip icon to view a definition of the metric.

Weekly Risk
Summary, Weekly
Project Risk, Risk
Report Card, and
Model Performance
tabs.

Tabs to navigate to the Weekly Risk Summary, Weekly Project Risk, Risk Report
Card, and Model Performance pages.

How to use the dashboard

• View projects that are at high risk for safety incidents by monitoring the Rank and Change
column for each project.

• Use the Change column number and arrows to see how much the risk rank of a project
has changed from the prior week.

• Select an individual project from the Project column to view the priorities and actions that
must be taken on the selected project. The priorities and actions are displayed on the right
pane.

• Hover over the Tool Tip icon to view a description of the metrics.

• Click the View Data button to view the metrics detail that was used to predict risks. This
data is an aggregation of the metrics across all projects.

Chapter 2
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Weekly Project Risk
Use the Weekly Project Risk Summary dashboard to view the risk predictions for a single
project.

You can use this dashboard to:

• View risk predictions for one project at a time.

• View the risk ranking.

• Review your project priorities and the actions you can take to mitigate potential safety
risks.

• View project details, and the weather forecast for the week.

• View the data that was used to display the risk predictions.

 

 
The following screen elements are displayed on the Weekly Project Risk dashboard:

Screen Elements Description

1 Project drop-down list. Select the drop-down list to select a project.

Note:

Some users may only have access to a single
project.
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Screen Elements Description

2 Project information and weekly rank. The following project information is displayed:

• Start date of the project.
• Finish date of the project.
• Duration of the project in weeks.
• Project percent complete by time.
• The project's group.
• Project type.
• Estimated value of the project.

3 View Project Data button. Select to view the data used to generate the dashboard.
The following metrics is displayed in the dialog box:

• Incidents: Total Last Week, Recordables Last Week, JTD Incidents, JTD
Recordables

• Observations: Total Last Week, Worker Observation Rate, Staff Observation
Rate, Average Observation Risk

• Trade Labor: Total Worker Days, Total Hours, Percent Apprentices,
Supervision Ratio

• Payroll/Head Count: Total Head Count, Total Hours, Safety Hours, Safety
Ratio

• Photos: Photo Count, Photo Coverage, Work at Height Composite

4 Displays the priority of the actions to take.

5 Feature priority and actions for the week ending.

6 Displays the weather forecast of the current week

Weekly Risk
Summary, Weekly
Project Risk, Risk
Report Card, and
Model Performance
tabs.

Tabs to navigate to the Weekly Risk Summary, Weekly Project Risk, Risk Report
Card, and Model Performance pages.

How to use the dashboard

• From the Project drop-down list, select a project.

• Review the project details and the weekly rank.

• View the priorities and actions that must be taken on the selected project.

• Hover over the Tool Tip icon to view a description of the metrics.

• View the metrics detail that was used to generate the risk predictions. Click the View Data
button.

Risk Report Card
Use the Risk Report Card dashboard to view if the safety risk metrics on projects have
changed compared to the previous week.

You can use this dashboard to:

• Review the risk mitigation actions for the selected week and prior weeks.

• Compare how well a project performed at following and implementing the
recommendations.

• View a project's risk ranking for a selected week and compare it with the prior week's
ranking.
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The following screen elements are displayed on the Risk Report Card dashboard:

Screen Elements Description

1 Project drop-down list. Select the drop-down list to select a project.

2 Displays the day the data was last imported. The risk rank is from the predictions
made prior to the week ending date specified.

3 Week Ending drop-down list. Select the week ending you want to review.

4 Selected Week's Rank. Displays the rank of the selected project, the change in
rank from the previous week, a red or green arrow indicating if the risks have
increased or decreased, and the date of the selected week ending.

5 Prior Week's Rank. Displays the rank of the selected project for the week prior to
the selected week ending, and the week ending date.

6 Actions of the Week. Displays the priority (High, Medium, or Low), the risk trend
(Up or Down arrow), and the recommended actions to mitigate the risks.

Weekly Risk
Summary, Weekly
Project Risk, Risk
Report Card, and
Model Performance
tabs.

Tabs to navigate to the Weekly Risk Summary, Weekly Project Risk, Risk Report
Card, and Model Performance pages.

How to use the dashboard

• From the Project drop-down list, select your project.

• From the Week Ending drop-down list, select a week ending date.

• Review the risk rank for the selected week and the prior week. Note if there was an
improvement in the ranking.

• Monitor if the project risk drivers are trending in the right direction.

• Review the priorities and actions that were recommended for the selected week ending.

Risk Level vs Incident History
Use the Risk Level vs Incident History dashboard to view if the safety risks associated with
your project were reduced compared to the previous weeks.
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You can use this dashboard to:

• Track the risk level of a project over the duration of the project.

• Track the incidents reported on the selected project.

• Track if a project has made progress in reducing safety risks.

 

 
The following screen elements are displayed on the Risk Level vs Incident History
dashboard:

Screen Elements Description

1 Project drop-down list. Displays the name of the project.
Select the drop-down list to select a project. Only the projects
you have access to are displayed.

2 Displays the day the data was last imported.

3 Filter button. Select to filter the projects list.

4 Incidents line chart. If an incident (minor or recordable) was
reported for a week, a line chart is plotted to display the
incident. A red line is displayed for recordables, and a yellow
line is used to denote minor incidents. If a week has both
minor and recordables, the line is displayed only in red. Click
on an incident line on the graph to filter the table and the
incident chart to only display incidents that are applicable to
the selected week ending.

5 Project Risk Level and Incident Timeline graph. Interactive
graph displays the risks levels along with the week endings.
Risk level is a value between 1 and 100 expressed in
percent. It reflects the percentage of projects that are ranked
lower than the selected project. The higher the value of risk
level, the higher the risk of the project have an incident.
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Screen Elements Description

6 Incidents Report table. Display all the incidents for the project
in increasing order of date. When the incident line is selected
from Incident Line chart, the data is filtered to show the
incidents for the selected week ending.

The following details are displayed (if available):

• Date of incident
• ID of the incident
• Type of the incident
• Injury
• OSHA status
• Severity. A value ranging from 1 to 7, where 1 is a near

miss and 7 is a fatality and 4 is a recordable. A caution
symbol is displayed for incidents of Severity 4 or more.

• Reported late

7 Incident chart: Displays a count of minor and recordable
incidents. Click on the chart to filter the table to show
incidents of the selected type (Minor or Recordables).

Weekly Risk Summary, Weekly Project Risk, Risk Report
Card, Risk Level vs Incident History, and Model Performance
tabs.

Tabs to navigate to the Weekly Risk Summary, Weekly
Project Risk, Risk Report Card, Risk Level vs Incident
History, and Model Performance pages.

How to use the dashboard

• From the Project drop-down list, select a project.

• Review the Project Risk Level and Incident Timeline graph to see how many risks and
incidents were reported on your project.

• Select the Incident line chart or the Incident chart to review the types of incidents that were
reported.

Model Performance
Use the Model Performance dashboard to assess if the risk models are accurately predicting
incidents across projects.

You can use this dashboard to:

• Compare the risk predictions with the actual outcomes.

• View the types of incidents that were reported for a selected project and the rank of that
project assigned by the model.

• Review if the recommended actions are helping to mitigate the risks.

 

Chapter 2
Risk Forecast Dashboards

2-15



 
The following screen elements are displayed on the Model Performance dashboard:

Screen Elements Description

1 Displays the day the data was last imported.

2 Filter button. Select to filter the projects list.

3 Week Ending drop-down. Select the week ending date you want to review.

4 The predicted rank for the project.

5 The name of the project. Click on the project name to open the Incidents panel.

6 Number of minor and recordable incidents reported for the project in the selected
week ending.

7 Incident chart. Display the total number of minor and recordable incidents for all
projects in a donut chart. The total number of incidents is displayed in the center.

Incidents panel Incidents panel. Select a project to display the Incidents panel. It displays all
incidents reported for the project.

The following details are displayed:

• Date of incident
• ID of the incident
• Type of the incident
• Injury
• OSHA status
• Severity. A value ranging from 1 to 7, where 1 is a near miss, 7 is a fatality,

and 4 is a recordable incident. A caution symbol is displayed for incidents of
Severity 4 or more.

• Reported late
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Screen Elements Description

Reason
Definitions button

Reason Definitions button. A dialog box displays the actionable and foundational
reasons or features that the model uses to make predictions.

Actionable reasons - Lists the features selected by the model as significant which
can be acted on by the project team. The corrective course of action is also
displayed.

Foundation reasons - Lists the features selected by the model as significant but
does not have any corrective course of action as these reasons cannot be acted on
by the project team.

Weekly Risk
Summary, Weekly
Project Risk, Risk
Report Card, and
Model Performance
tabs.

Tabs to navigate to the Weekly Risk Summary, Weekly Project Risk, Risk Report
Card, and Model Performance pages are displayed at the bottom of the page.

How to use the dashboard

• From the Week Ending drop-down list, select a week.

• Review the projected risk rank for all projects that have at least one minor or recordable
incident. If all or most of your projects are in green, then the model is performing well. If
most or all the project ranks are yellow, orange or red, it indicates that model did perform
well for the selected week and may need to be retrained.

• Review the donut chart representing the total number of incidents (minor and recordable).

• Select a project to view the incident pane. Review the details of each incident from the
pane.

• Select the chart to filter the incident table.
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